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Introductory Economics Lab


http://www.depauw.edu/learn/introeconlab
Excel Workbook: Unemployment.xls
Unemployment Lab

Introduction

This lab has two goals:

1) To help you understand how unemployment and labor force participation rates are computed.

2) To give you experience in working with online data.  


Open the Unemployment.xls workbook and read the Intro sheet.  


If you haven’t already, you should read the chapter or chapters in your textbook on unemployment.  Read about the BLS and the monthly survey they conduct to determine if the respondent is in or out of the labor force and employed or unemployed.  Your textbook may have graphs or tables of unemployment rates for different demographic groups.  Make sure you understand that the unemployment rate varies quite a bit over time, rising when the economy is doing badly and falling during a boom. 


Proceed to the Definitions sheet.  Click the buttons and read the information that is displayed.

Notice that the entire civilian population is neatly divided into a series of mutually exclusive categories.  You either are under 16 years old or 16 years and over.  There is no other possibility.  The same holds true for the other forks in the organizational scheme.


Q1) Suppose the population and labor force numbers were unchanged in the Definitions sheet, but the number unemployed rose to 8 million.  How would this affect the unemployment and labor force participation rates?

	Enter your answer in this box.  The box expands as you type in text.



Q2-A) Do the unemployment and labor force participation rates have to add up to 100%?  Show why or why not. 
	Enter your answer in this box. 



Q2-B) The Employment Rate is the Number Employed divided by the Number in the Labor Force.  Do the unemployment and employment rates have to add up to 100%?  Show why or why not.

	Enter your answer in this box. 



Proceed to the BLSData sheet, but don’t start clicking yet.  Read the description below before you start to work.

This sheet has a series of web links and steps that you will be following to actually download and analyze US labor force data.

The BLS web site has a lot of pre-packaged data, but this lab is geared toward showing students how to create their own data sets.  

There is a premium on careful reading and close attention to detail.  Please take your time and pay attention to the instructions.  

You can be easily frustrated.  The BLS slightly changes the look of the site in regular upgrades so the instructions and screenshots in the lab may not exactly match what’s on the computer screen. 

The main page you will be working with is an interactive database that enables you to select variables.  It will look something like this:
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WARNING:  It is important that you carefully read the web pages as they are displayed.

Fast clicking and skimming is a really bad strategy here.

For example, the main page explains how you can choose the year range of your data and make other changes with the “Reformat” button and tells you that annual data is only available in the “Not seasonally adjusted” series.


Carefully follow the first two steps in the BLSData sheet to get seasonally adjusted, monthly unemployment rate data (Series Id: LNS14000000), but don’t worry about the Data Re-organizer button (in Step 3) just yet.  Once you get the data, scroll back up to the top of the web page and change the years so that you get unemployment rates from 2000 to 2010.  You should have monthly unemployment rates.


Q3) Since 2000, what was the lowest unemployment rate?  When was it?  

Hint: Scanning numbers by eye is a dangerous way to answer this question—after all, you might simply overlook the answer.  Excel’s MIN function is a cleaner, more elegant way to answer the question.

	Enter your answer in this box. 



Q4) Is your answer to Q3 considered to be a “good” unemployment rate?  Explain.

	Enter your answer in this box. 



Q5) Since 2000, what was the highest unemployment rate? When was it?   Describe your procedure for answering this question.

	Enter your answer in this box.       



Q6) With a labor force of roughly 145 million in June of 2003, roughly how many people were unemployed in the US in June of 2003?  Show your work. 

	Enter your answer in this box.       



Use the [image: image2.wmf]Data Re-organizer

 button to make the unemployment series a long, tall column.

The picture below shows that the original, rectangular data in Sheet1 was selected, including the Year column and monthly row labels (thus, the Labels in the First Row option was checked).  You click on the Input Range and then select the data.  Do not include the empty Annual column (if you have one).  The output is being sent to a new worksheet. 
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Q7) Since 2000, what was the biggest monthly percentage point increase (not percentage increase)? When did it occur?

	Enter your answer in this box.       



Q8) What do you think was happening to Real GDP from April to May of 2008?  Why do you think this?

	Enter your answer in this box.       


Next, we want to draw a graph of the data series using our usual Scatter chart with year as the x axis. Unfortunately, the Year and Month values are in separate columns.  We must join, or concatenate, them.  Excel’s concatenation operator is the ampersand, &.  Search Excel’s Help for “concatenate” and you will see that “&” is the same as writing “concatenate.”  

Please be aware that the instructions described below must be followed with care.  The procedure involves somewhat advanced methods in Excel. If you are careful and persevere, you will learn powerful, general methods for dealing with data in Excel.

To use the concatenation operator to join the Year and Month cells, you create a formula, using “&” to join various cells or your own text.  We’ll practice with Jan-1994 as an example.


Insert a new sheet into the workbook and type “1994” in cell A2 and “Jan” in cell B2.  
You want to join these two cells so Excel can read the result as a date, “Jan-1994.”  The formula =B2&"-"&A2 does exactly this.  The formula joins the value in cell B2, Jan, with a hyphen.  So B2&"-" forms Jan-.  Then, it tacks on the value of cell A2, 1994, to form the entire date.  Notice how the formula puts B2 first, then A2 because we want Jan-1994.

In cell C2, enter the formula, =B2&"-"&A2.

Unfortunately, you aren’t done yet.  Excel does not recognize the new string you have just created, Jan-2004, as a number.  One subtle sign of this is that the date is left-justified.  As a rule (and unless the user changes the justification or formats the cell), Excel always displays numbers as right-justified.  You have to convert the dates to numbers.  Excel’s Help explains how to do this:

Numbers aren't displayed or calculated as numeric values.

If the numbers are aligned to the left of the cell and if you have not changed the default alignment (General), the numbers are formatted or entered as text. To change the numbers to numeric data, do the following. 

1. Select a blank cell that you know has the “General”  number format, e.g., cell D2. 

If you aren't sure of the cell format, in Excel 2007 or greater, click Cells on the Format group on the Home tab, and select Format Cells. In the Number tab, in Category box, click General, and then click OK. 
In older versions of Excel, click Cells on the Format menu, and then click the Number tab. In the Category box, click General, and then click OK. 

2. In the cell, type 1 and then press ENTER.

3. Click the cell, and copy it (ctrl-c).
4. Select the range of cells, in this case C2, that contain the "text" numbers.

5. In Excel 2007 or greater, click the down arrow on the Paste button in the Home tab and click Paste Special, then choose Multiply, and then click OK. 
In earlier versions of Excel, on the Edit menu, click Paste Special, then choose Multiply, and then click OK. 

The idea behind these instructions is to multiply the concatenated cells by the number 1 so that the text string (e.g., Jan-94) is converted into a number (e.g., 34335).  You can then format these numbers as a date.

Select cell C2 that you have converted into a number and bring up the Format Cells dialog box again.  Click the Number tab and choose the Month-Year date format.  The number 34335 is now displayed as Jan-1994.  This is the number of days since Jan 1, 1900 (including leap years, of course).  Access Excel’s Help (search for “date”) to learn more about how Excel deals with time.  The bottom line is that all time variables (days, hours, etc.) are stored as sequential numbers that can be used in a computation, such as adding, subtracting, or as a numerical x axis in a chart!


You are now ready to apply this knowledge to the month and year columns in your data. Good luck!
Note: If you are going crazy and can’t get the concatenation and conversion to a number to work, you can easily create your own date column by entering Jan-2000 in a cell, Feb-2000, in the cell below it, selecting both cells, and then filling down.  Excel will continue the pattern for you.


Q9-A) Make a well-labeled chart of your unemployment data.  Make sure the x axis is time and the y axis the unemployment rate.  Copy the chart as a picture and paste it in the box below.
	Paste your picture in this box. 



Q9-B) Comment on the chart. What does it say about the economy during the decade?

	Enter your answer in this box.       



Return to the BLSData sheet.  Carefully follow the same steps as before to get NOT seasonally adjusted, monthly unemployment rate data (Series Id: LNU04000000) for the same data range..

Our goal is to place both the seasonally and not seasonally adjusted series on the same chart so we can compare them.  Here are the steps.


 Use the [image: image4.wmf]Data Re-organizer

 button to make the not seasonally adjusted unemployment series a long, tall column.


 Copy the not seasonally adjusted unemployment data and paste it on the same sheet as the seasonally adjusted data (with the numeric date values).


Q10) Create a well-labeled chart that compares the seasonally adjusted and not seasonally adjusted unemployment data.  Copy the chart as a picture and paste it in the box below.
	Paste your picture in this box. 



Q11) In general terms, how does the seasonally adjusted series differ from the not seasonally adjusted series?

	Enter your answer in this box.       


Beyond the Basic Unemployment Rate

In addition to the total unemployment rate based on the entire civilian population aged 16 and over, there are unemployment rates for many sub-categories.  There are also other statistics that can be used to analyze the labor market.  This lab will examine just a few of these.  We begin with teenage unemployment.


Return to the BLSData sheet.  Carefully follow the steps to get seasonally adjusted, monthly unemployment rate data for teenagers (Both sexes, age 16 to 19, Series Id: LNS14000012).


Q12-A) How does the teenage unemployment rate compare to the overall unemployment rate?

	Enter your answer in this box.       



Q12-B) Why is the teenage unemployment rate so high?

	Enter your answer in this box.       


Another sub-category of the unemployment rate uses educational attainment.  We want to know if the unemployment rate differs for people with different levels of education and, if so, by how much.


On the left-hand side of the main page (http://www.bls.gov/webapps/legacy/cpsatab1.htm) a list of different tables is shown. Click on table A-4, as shown in the following picture:
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Get the seasonally adjusted, monthly unemployment rate for each of the four categories of educational attainment.

Q13-A) Create a chart that compares the unemployment rate by educational attainment.

	Paste your picture in this box. 



Q13-B) Does your chart show any differences in unemployment rates for the four groups?  Explain.

	Enter your answer in this box.       



Return to the BLSData sheet.  Carefully follow the steps to get annual labor force participation rate data for all (Total) men and women 16 and over from 1948 to 2010.  Since you want annual data, you have to choose from the “Not Seasonally Adjusted” column.


After you get the data, the screenshot below shows that you have to click the More Formatting Options button and then set the “Specify year range” and “Select one time period and “Annual Data” options. 
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The Male LFPR Series ID is LNU01300001.

The Female LFPR Series ID is LNU01300002.


Q14-A) Identify the lowest and highest values of the Female LFPR.  When did each one occur?

	Enter your answer in this box.       



Q14-B) Create a chart that compares the Male and Female LFPR from 1948 to 2010. Copy the chart as a picture and paste it in the box below.
	Paste your picture in this box. 



Q15) Use your chart to comment on any outstanding trends.  What does your chart reveal?

	Enter your answer in this box.       




Congratulations! You have finished the unemployment lab.

Save this document and print it. 

You can save a lot of paper and ink by cutting everything out of the final, printed version except the questions and your answers.







All four different educational attainments are checked.





Marquee shows that Year and Month labels were selected.








Unemployment.doc
Page 1 of 11

